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C O M M A N D. C O M
Attendance at the
January general meeting:
63 members and guests.

To Contact CIPCUG
The Outer Edge......................805-485-7121
General Information………...805-289-3960
Mailing Address...P.O. Box 51354, Oxnard, CA
93031-1354
On the Web: cipcug.org
On Facebook: Facebook.com/groups/cipcug

Meeting dates change
Reminder: This month’s meeting will be
on Feb. 16, rather than Feb. 23, because of
an event at the Boys & Girls Club. We’ll
return to the regular schedule in March.
The date of the Linux SIG has also been
changed — to Wednesday, Feb. 27.

Computer tuneups coming
This one has a big difference from the previous events. Anyone who joins CIPCUG between now and the date of the tuneups can
have one for free. All the details are on page 7.

Please complete the survey
The CIPCUG survey on cipcug.org is
working. Please complete the survey online or
by clipping the version in last month’s TOE to
help determine the society’s future.

By Jim Brown, President
“Promoting the Harmony of Computer Education, and Camaraderie”

H

ere is a list of items that will be discussed at our February meeting:
We are scheduling a computer tuneup for your PCs for the
April meeting. The usual fee is $15.
If a new member joins our computer group from January to April, we will
offer the tuneup free of charge
We will update the new flash drives for $2. If you wish to load your old
CIPCUG flash drive, we will do it for $5.
The raffle in April will include a big buck item. Craig Ladd, our vicepresident, will determine if this will be a tablet or other item. The raffle ticket
prices will be $5 each or five tickets for $20. This will be similar to the raffle
at our 25th anniversary celebration last September.
We printed business cards for our computer group. The
purpose is to give you something to give to prospective members. The card has all the information needed to inform people
about our meetings and help them connect to our group. We
anticipate that this will make it easier for all of us to give
complete information to others. These business cards will be
Brown
distributed at our February meeting and will be available at
future meetings.
Have you participated in our club survey yet? Your board wants to hear
your views and opinions. John Weigle and Toby Scott devoted many hours to
this project. You can find the survey on our website — www.cipcug.org.
Please participate. While you are there, take a look at our computer club bylaws. We have an election of officers — especially the office of president —
coming up in the spring.
One of our members, Shlomo Kreitzer, has received an award for his
writing. We would like to share his award-winning short story with you:
To see the story:
1. Copy and paste this website into your browser address bar:
www.VenturaCountyWriters.com/contests/short-story.
2. Go to that site.
3. This will bring you to another page. Scroll down a little and then dou(Continued on page 3)
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CIPCUG news and events
Coming events
Short takes on this
issue and other matters February program

C

orrection: David Minkin sent me an email after
receiving the last issue and said he had found that
the Sharpies for writing on CDs are available at
Staples. I had found them at Office Depot in
Ventura but did not see them in the Staples store in Oxnard
or Ventura. David lives in Camarillo, so I assume that’s the
store he found them.
Editor’s
This issue had to be put together faster than
corner
usual because of the change in our February
meeting date from the fourth Saturday to the
third Saturday. My thanks to the regular TOE
contributors who made it possible to meet the
early deadline.
I’ve been having some strange computer
problems on Sunday, Feb. 3, when most of
Weigle
the layout and editing of the issue was being
done. I don’t know if the computer is just getting tired or if
there’s something much more serious. The strangest thing
that happened so far was that when I saved TOE from the
menu, all the new content on the page I was working on at
the time vanished. Fortunately, CTRL+Z brought it back,
but it’s disconcerting to say the least.
With luck this won’t keep happening, or if it does, I’ll
notice the empty page before sending the file to the printer.
You’ll know what happened when you get the issue. (A
repair installation of Office seemed to fix the problems.)
From the CIPCUG Facebook page
● Knome’s new machine to aid labs in genomic analysis.
● F.T.C. suggests ‘do-not-track’ feature for mobile software and apps.
● Mally is an email app designed specifically for children in mind.
● Mozilla takes drastic step to automatically block virtuall all plug-ins in Firefox. — John Weigle, editor

More on Command.com ...
(Continued from page 1)

ble click on red “Message from Sharon,” the title of his story
(next to Shlomo’s name).
4. Click [OK] to open the PDF of his story.
Finally, our February meeting will be held on the THIRD
Saturday of the month. The Boys & Girls Club needs our
room for another event. So Feb. 16 is our meeting date.
Our March meeting will be on our usual schedule of the
fourth Saturday of the month — March 23.
Hope to see all of you at the February meeting.

will be announced
Programs
No program had been confirmed for February by the deadline
for this issue. The Feb. 16 meeting — a week earlier than our usual meeting date — will be at the Camarillo Boys & Girls Club,
1500 Temple Ave. (Ponderosa Drive and Temple Avenue), Camarillo (see the map on the last page). Watch the website at cipcug.org for a program announcement.
The doors will open at 8 a.m. and the program will start at
8:45 a.m. We expect to have both the Internet and Connectivity
SIG led by Toby Scott and a Social Media, Alternative Devices
SIG (smartphones, tablets, etc.) led by Jessica Scott.
Dates of coming meetings follow:
March 23
April 27
May 25
June 22
July 27
Aug. 24
Sept. 28
(Continued on page 4)

Door prizes
We have two types of raffle tickets: one for prizes offered by
the presenter and one for club-provided prizes. The tickets for the
presenter’s prizes are free and limited to one per member.
The tickets for the club-provided prizes are $1 each, $5 for six
tickets, $10 for 13 tickets, $15 for 20 tickets and $20 for 27 tickets
and are available to anyone. Those who can’t stay until the
drawing may sign their tickets and give the person selling the
tickets a list of the prizes they would like in the order they’d pick
them. Winners’ prizes will be held until the next meeting.

Consignment table
A consignment table is set up at every meeting. Anyone can
buy, but only members can sell.
The club gets 10 percent of the sales price. Sold items must
be picked up at the end of the day’s meeting.
Any items not picked up will become the property of CIPCUG
and will be subject to disposal at the club’s discretion.
CIPCUG is not responsible in any way for items bought or
sold at the table. Each item is sold as-is unless otherwise stated.

Meeting, SIG notices
If you would like e-mail notices of regular meetings and SIGs,
go to www.cipcug.org, where you’ll find a link on the home page
to sign up. The URL is cipcug.org/listserv.cfm.
You will need your membership number, which is on the
back cover of TOE, to complete the sign-up.
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CIPCUG news and events
Internet SIG, Q&A

Emails in Chinese, redirecting messages
Unless otherwise noted, Toby Scott
answered the questions in the SIG and
the regular Q&A, assisted by Michael
Shalkey, who also handled the computer
duties for both sessions.
Internet and networking SIG
Chinese emails
Q: I’m getting lots of emails in Chinese at my CIPCUG address.
A: There is a lot more Chinese spam
coming in as the Chinese market grows
and more companies try to sell there.
You’ll get more spam like this in email
than in the regular mail because sending
things by regular mail costs more — paper, envelopes, and postage. Email can be
sent at little or no cost, so the spammers
buy the cheapest mailing lists they can
find and spew messages out to the world.
They don’t care if only a small number of
recipients respond because the cost of the
mailing is practically nil. Recipients who
don’t want the messages just delete them.
Windows 8 upgrade
Q: Isn’t the special price to upgrade to
Windows 8 if we have Windows 7 almost

over? Should I upgrade to 8 if I have 7?
A: As of the meeting date, the special
$39.99 upgrade price was scheduled to
end Jan. 31. I think most people have no
immediate reason to upgrade to Windows
8 from Windows 7, but I recommend
buying the upgrade at this price anyway.
You’ll get a small program that checks to
see if your computer is compatible with
Windows 8, a link to get the installation
program and, via email, the key code.
Keep the key code in a safe place where
you can find it; you don’t have to download the program unless you want to because any Windows 8 disc will work.
We’re going to try to make DVDs available at the next meeting. I recommend this
because you’ll probably want to upgrade
to Windows 8 before the Windows 7 support time ends, and you’ll never get it
cheaper than this.
Front Page in Windows 8
Q: I upgraded to Windows 8 from
Windows 7 and got a message that Front
Page wouldn’t work, but it seems to.
A: If you’re doing just a small site,

many of the functions will work, but
you’ll probably have some problems with
some of the robust tools to communicate
with the online page. Some pages won’t
display properly.
Email addresses
Q: I want to change my email address.
Is it possible to have messages redirected
to the new address?
A: Probably not. I can, and will, do it
for free, but many providers either can’t
or won’t make the effort. You can ask,
but it probably won’t happen.
Email ads
Q: I get emails from friends that are
ads. Have they been hacked?
A: Do you open the email or click on
any links in it? If you clicked on the link
you probably got the same thing your
friend had. It’s called HTML infection.
Anti-malware programs have to know
that the links lead to an infected site before they’ll stop you from going there.
It’s a continuing effort for the anti(Continued on page 5)

More on coming events ...
(Continued from page 3)

Oct. 26
Nov. 16 (third Saturday)
Dec. 21 (third Saturday)
SIGs
The Special Interest Groups (SIGs)
are sponsored by CIPCUG and led by
volunteer club members. They are free to
CIPCUG members.
Other than those presented during or
just after the regular meeting, the SIGs
run from 6:30 to 8:30 p.m. at Ventura
County Computers, 2175 Goodyear Ave.,
Unit 117, Ventura; phone 289-3960.
From the 101 Freeway, exit at Telephone,
take Telephone south to McGrath, turn
left and go one block. Turn right on
Goodyear and right again into the second

driveway. Unit 117 is the back, right
corner of the building.
The pre-meeting SIGs are at 8:45 a.m.
at the Boys & Girls Club. The aftermeeting SIG when one occurs is at a location to be announced on the meeting
day.
The general schedule:
Fourth Tuesday: Linux.
Fourth Saturday (or the regular
meeting day): Social Media SIG (Jessica
Scott) and Internet and connectivity SIG
(Toby Scott), 8:45 a.m. The location of
Michael Shalkey’s after-meeting SIG, on
days there is one is announced at the
meeting.
The February and March schedules:
February
Saturday, Feb. 16: Pre-meeting SIGs

on Social Media/Other Devices and Internet and email at 8:45 a.m.
Wednesday, Feb. 27 (note the date
change here, too) : Linux SIG. Moderator: Bill Wayson. With luck, we will finally get Ubuntu installed on our refreshed CIPCUG PC. Of course, we can
talk about the Raspberry Pi or anything
else that interests you.
March
Saturday, March 23: Pre-meeting
SIGs on Social Media and Internet and
connectivity at 8:45 a.m.
Tuesday, March 26: Linux SIG.
Moderator: Bill Wayson. Topic: TBA.
Be sure to check the calendar on
cipcug.org for updates on event programs, dates and times.
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CIPCUG news and events
(Continued from page 4)

malware developers to learn of threats
and update their lists of what sites to
block. The infected sites keep changing.
Q: If I get an email I don’t want I
have to click on it to delete it.
A: If you’re using a program that
shows a preview of the message, you
won’t get a virus by clicking to delete the
message. You won’t get a virus just looking at the preview. You can delete the
message. It’s when you click on the ad
that you get in trouble. It’s a good idea to
turn off the preview of pictures in email.
In Outlook 2010, go to File > Options >
Trust Center > Trust Center Settings.
Click on Don’t Download Pictures Automatically, but check Permit Downloads in
E-mail Messages From Senders . . . Defined in the Safe Senders . . . Lists. Turning off Live Preview improves security
but not by a huge amount.
Pictures lose color
Q: If I put a picture in IrfanView and
then copy it into my email it goes to black
and white. If I send it as an attachment,
it’s fine.
A: You want to save it as a picture.
You want to “Send to” or “Open with”
rather than copying. If you save the
graphic to a file and then open the file in
IrfanView, it will have normal color.
Michael Shalkey: It also depends on
how you’re adding it to the email.
(During the regular Q&A, Michael
demonstrated IrfanView and noted that
Ctrl + G turns color pictures into black
and white and suggested that might be
what caused the problem.)
Comment: I often copy an image from
Facebook and try to put it in email, and it
doesn’t work. If I put in IrfanView, it
does work.
MailWasher
Comment: I’ve been using MailWasher as a spam filter for 10 years and would
never open mail without it. It lets me see
the first 20 lines of a message, and I can
delete the messages I don’t want without
ever downloading them. I’ve ended up
with only about 25 percent of the mail I
used to get. (More details on page 9.)
Toby: MailWasher works very well,
but I prefer to sort my mail with rules in
Outlook to direct messages to a variety of

Internet SIG

This month’s Q&A topics:

Chinese emails
Windows 8 upgrade
Front Page in Windows 8
Redirecting email
Email ads
Pictures lose color
Mailwasher
Downloads, desktop icons
KeePass
Alternative to Internet Explorer
Keyboard shortcuts
Low virtual memory

Java security issues
Updating Java
Google Upgrader a virus?
Protecting other devices
Adobe Reader
Spybot
Alphabetizing bookmarks
Forwarding emails
Erasing hard drive
Messages from Helen

folders, including Spam. I just find that
easier for the way I work, but not everyone agrees.
Downloads
Q: First, if I have a lot of downloaded
program files and have finished with
them, can I delete them? Second, to keep
track of them, can I move them to the
desktop?
A: You can delete the files or move
them elsewhere, which shouldn’t be a
problem with today’s large hard drives.
If you download to the desktop, after
you’ve used the files, move them off the
desktop — to a downloads or temp folder,
for instance — because every icon on the
desktop takes up a small amount of RAM
(random access memory). If you get
enough icons on the desktop, you’ll slow
down your computer. Items on the
taskbar also take up some RAM. If you
have a Download folder, create a shortcut
to that folder rather than to every downloaded file.
Q: If I delete shortcuts from the desktop, I’m not deleting programs, am I?
A: No. For example, every time Adobe updates its Reader, it puts a shortcut
on the desktop. Get rid of it (or don’t allow it). No one opens Reader and then
browses to the PDF. They find the PDF
and click on it, which opens the default
PDF reader, so there’s no need for a desktop shortcut. Three-quarters of the
shortcuts that most of you have on your
desktops you’ll never use.
Q: Could I make a folder and move
shortcuts to it?
A: That mitigates the problem to some
extent, but it’s better to put them in a reg-

ular folder off the desktop with a shortcut
to that folder on the Desktop.
Q: In Windows 7 on the second Tuesday of the month (Patch Tuesday), I get
lots of updates from Microsoft. Updates
install and force a reboot. Then I get a
message that Google is not responding. I
have to keep doing system restores,
which take about an hour.
A: Using System Restore that way
just pushes the problem to the next Patch
Tuesday because System Restore takes
out all the updates, and they’ll be downloaded again, and the problem will be
repeated.
Comment: Not exactly, because after I
use System Restore, I download all the
updates but install only a few at a time to
try to find the problem one(s). When I
reboot, Chrome works, but Internet Explorer 9 does not. I had the same thing
with IE 8.
Michael: You have a problem with
Internet Explorer, and we don’t know
what it is. We’ve faced the same thing in
the shop.
(An Internet search found lots of posts
on this problem spread over several years.
One answer offered is to use a browser
other than Internet Explorer. — Editor)
Q: Can’t you repair or reinstall failed
updates?
A: He does that, and the next update
kills it.
Michael Shalkey: Try creating a new
administrator’s account — such as Test or
Temp — in the Control Panel > User Accounts, and see if that works. I’m not sure
it will, so please report back at the next
(Continued on page 6)
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meeting. We’re going to try it in the shop
on Monday. If it works, just move your
documents over to the new user.
KeePass
Q: Are you going to demonstrate
KeePass? I loaded it once and couldn’t
figure it out.
A: Not today, but I’ll consider doing
so. It takes a lot of time to set it up, and
it’s tricky to demonstrate.
Alternative to Internet Explorer
Q: What is the alternative to Internet
Explorer for sites that insist on IE? When
we do tax preparation, some sites insist
on IE.
A: IE Tab in Firefox. If you use IE
and have sites that don’t open in Chrome
or Firefox, don’t upgrade to IE 10 because they won’t work there either. The
sites that don’t work do not comply with
standards, and after losing a large share of
the browser market, Microsoft decided to
make a compliant browser, thus breaking
a lot of old, non-compliant Web pages.
Michael Shalkey: Go to Tools > Add
ons > Get add ons to add IE Tab if you
don’t have it or to find options for it if it’s
installed. I like the version from Taiwan.
You can right click on a link you want
Firefox to open in IE Tab and pick that
option. You can also create a list of links
in IE Tab that you want it to open automatically by going to Tools > Add ons >
IE Tab and clicking on the options button).
Keyboard shortcuts
Q: Where can I find a list of keyboard
shortcuts?
A: There are many shortcuts for both
Windows and individual programs. Do a
search for keyboard shortcuts and find the
ones you’re most likely to use a lot.
(Coincidentally, Jim Thornton sent an
article with lots of Windows shortcuts
afer the meeting; it starts on page 13 —
Editor)
Michael Shalkey: If you really like
shortcuts, you’ll love Windows 8. It has
more shortcuts than any other version.
(Two helpful sites for Microsoft software: Windows 7 shortcuts at http://
windows.microsoft.com/en-US/
windows7/Keyboard-shortcuts.
(Other Microsoft programs at http://

www.microsoft.com/enable/products/
keyboard.aspx — Editor)
Low virtual memory
Q: I’m getting “virtual memory is
low” messages in XP.
A: You have too many things running.
Shut some of them down. If you have lots
of shortcuts or files on your desktop,
move them somewhere else.
If you get a message to try a Microsoft FixIt tool for a problem, try it. It
usually solves the problem.
Michael Shalkey: Find KB 826513 at
support.microsoft.com/kb/826513. It has
instructions for Windows XP and Windows 2000.
Toby Scott: The problem seldom
comes up in Windows Vista or 7.
Q&A January 2013
Java security issues
Toby Scott: There has been a lot of
talk recently about security problems with
Java, and the situation has not improved
much. The U.S. Department of Homeland
Security has issued an advisory to disable
it in all devices, and some security experts say it could take up to two years to
make the program secure. Java, which is
not related to JavaScript except for the
unfortunate use of “Java” in both names,
is used in desktop computers, laptop computers, tablets, smart phones and many
other devices. It and Adobe Reader are
among the top sources of malware infestation because both are used on so many
devices. If you’ve heard the term “zero
day exploit,” it means that the vulnerability was present when the program was
released.
Java was developed by Sun, which
was bought by Oracle, the current developer. Oracle released a patch that fixed
only some of the security problems. The
Department of Homeland Security said
the patch was not sufficient because all
hackers had to do to get around it was
change their code a bit.
My advice is not to uninstall Java
because some websites, including many
financial sites, won’t run without it. Keep
it up to date religiously and disable it in
your browsers. (Instructions for all major
browsers
are
at
http://
gizmodo.com/5975475/how-to-disable-

java-in-your-browser.) Allow it in just
one browser that you don’t use for anything else.
Java is a programming language. If
you click on a link to run a program, it
runs on your computer. If you block it in
your browsers, you can’t go to a malicious online site and get infected. Java is
also used in lots of programs, so if you
just remove it you might kill some programs you use regularly.
Java can also get on to your computer
via CDs, DVDs, flash drives and floppies.
Some sites will say they need Java; just
don’t go to most of them.
Q: Lots of sites don’t work without
Java, including banking, travel and tax
sites.
A: If you face that situation, disable
Java in all but one of your browsers. If
you have only Internet Explorer, download and install Opera, Firefox or
Chrome. Let one of those browsers — not
Internet Explorer — use Java and then
use it only to visit those trusted sites that
require Java. Don’t go to unknown travel
sites, just ones you’re already familiar
with and know are legitimate. Don’t use
the Java-enabled browser to conduct
searches or click on links.
Here are the basic instructions to disable Java in several browsers:
Internet Explorer: Go to Manage Addons > Show All. Disable all the items
listed under Java. Restart the browser.
Firefox: Go to Tools > Add-ons >
Plugins. Disable all the items listed under
Java. Restart the browser.
Chrome: In the address bar, type
“chrome://plugins” without the quotes,
which brings up a new tab. Find the Java
listing and click on Disable. Restart the
browser.
Updating Java
Q: How do I keep Java up to date?
A: An “update is available” notice
usually appears in your toolbar. If you
don’t see one, go to http://www.java.com/
en/download/index.jsp to download the
latest version. Don’t turn off the install
nags. If you have the latest versions, you
can go to Control Panel > Java to make
some adjustments in the program.
(Continued on page 7)
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Comment: I disabled it in all browsers
just by going through the Control Panel.
A: That works if you want to disable
it in all browsers. But if you want to leave
it running on one browser, you have to
disable each browser individually.
Q: I went to the download site and
asked it to check my version of Flash, and
it couldn’t find it in Firefox. It found it
using a different browser.
A: Once you disable Java in a browser, the site can’t locate the program because it uses Java to do so. Firefox’s
NoScript might also have blocked it.
Michael Shalkey: Be very careful
when you install an update or new version. Read each screen because Java
wants to install the Ask toolbar and
change your home page, and the default
setting is Agree. You want to uncheck it.
In the newest version go to Control
Panel > Java > Security and disable it
there.
Q: I got a message from Norton that
said not to worry about the Java problems
because Norton’s programs are fixing the
problems. Is that too optimistic?
A: It’s more optimistic than I would
be, even though Norton pushes updates
out almost hourly.
The difficulty is that Java is used on
many devices, and we’re still looking for
the right security programs to handle it on
all the devices except desktop and laptop
computers, where all the procedures are
pretty well known.
Google Upgrader a virus?
Q: My anti-virus program flagged
Google Upgrader as malware. I understand it might have some problems. Can
you comment on that?
A: I think it was a false positive —
calling something a virus when it isn’t.
All the anti-virus programs have some
problems like that with some programs.
Some anti-virus programs detect that
VNC on the CIPCUG flash drive is a vi-

rus. It’s not a virus and is OK.
Comment: I reinstalled Google, and
the messages stopped.
Protecting other devices
Q: How do I detect other devices that
Java is on?
A: Computers are a mature technology, so writing anti-malware software for
them is fairly easy. Many people get new
smartphones every two years because of
contracts, so it’s more difficult to keep up
with the software involved. Java is going
to be a real and continuing problem. I
know of two Android anti-virus programs.
Comment: The Safari browser on the
iPhone lets you turn Java off in it.
Toby Scott: But many apps also use
Java. The industry really doesn’t know
how to handle the problem yet.
Adobe Reader
Q: You said some time ago to change
settings in Adobe Reader, but I’ve forgotten what you suggested.
A: Major upgrades (from version 10
to version 11, for instance) seem to restore all the default settings. To fix them,
open any PDF file, which opens the
Reader (if it’s your default PDF reader).
Go to Edit > Preferences > Java Script
and uncheck the “Enable Adobe JavaScript” box. Then go to Edit > Preferences > Trust Manager and uncheck the
“Allow opening of non-PDF attachments
with external attachments” (thus, programs on your computer or on the Web)
box. If the Acrobat Reader is not your
default PDF reader, you can open it separately or by right clicking on any PDF
document and selecting it from the “Open
with” list.
Adobe, like Java, is the distributor of
a lot of security problems in its software.
Spybot
Q: Is Spybot 2.0 on the flash drive?
Will you explain why each scan asks me
to immunize every time? How do things
get un-immunized?

A: Yes, the new version is on the flash
drive.
You misunderstand what the immunization is. There is a file in Spybot that
overrides some Internet settings on where
you can go. The lists let Spybot block
those sites. The reimmunize option updates the lists of sites to block.
Alphabetizing bookmarks
Q: How do I alphabetize my Firefox
bookmarks?
A: In Firefox, Click on Bookmarks >
Organize bookmarks > View > Sort - Sort
by name.
Forwarding emails
Q: Can I send all my CIPCUG and
Yahoo messages to Gmail so I can check
only one account?
A: I can do the CIPCUG messages for
you. I don’t think Yahoo can do that.
(The Gmail help file confirms that
Yahoo does not support free POP access.
Neither do Windows Live Hotmail, and
Mail.com. — Editor)
Erasing hard drive
Q: I want to sell my laptop. How can I
be sure information on my hard drive has
been completely deleted?
A: Simply deleting everything and
emptying the trash doesn’t do it. The
drive must be overwritten several times.
Michael can do it for a fee. The other
alternative is to destroy the hard drive.
Messages from Helen
Toby Scott: Helen Long had strange
problems that spewed thousands of spam
messages from her address. We’ve temporarily turned off her account and are
trying to find the problem on her computer.
Some of you might get some more of
the messages when her account is turned
back on. Just delete them. There might
also be some slow times as we test her
machine and account to be sure the problem is solved. It should certainly be fixed
long before you receive this issue.

New members eligible for free computer tuneup
The next computer tuneup will be
Any nonmembers who register for the get the tuneup for free. The price for
offered at the April meeting with a spe- event on cipcug.org and join CIPCUG members is $15.
cial twist to attract new members.
from January to the April meeting will
(Continued on page 8)
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The picture on the left shows the opening screen of Portable Apps. The large pane on the left shows installed
Apps (screen shot from a local installation). The photo on the right is the location window for Stellarium showing a panorama from the European Organization for Astronomical Research in the Southern Hemisphere
facilities in Garching, near Munich, Germany (screen shot from the Stellarium website..

Program: CIPCUG flash drive

Several freeware programs demonstrated
By John Weigle
jweigle@vcnet.com
everal of the programs on the
CIPCUG freeware flash drive
were demonstrated by Toby
Scott and Michael Shalkey at the
January meeting.
All the additional flash drives were
sold during the meeting, and the board
decided to prepare more in time for the
February meeting. A complete list of the
programs is on cipcug.org and on the
flash drive. If you’re interested in a
demonstration of other programs — or

S

would like to demonstrate one yourself
— please pass the word to Craig Ladd or
Toby Scott.
Portable Apps
The flash drive contains the basic
Portable Apps platform installer. Once
you install it, you can find hundreds of
available
apps
at
http://
www.portableapps.com, where you can
also subscribe to a newsletter that reports
on new and updated apps. Apps are available in the following categories: accessibility, development, education, games,
graphics and pictures, Internet, music and

More on tuneups ...
(Continued from page 7)

Staff members from Ventura County
Computers will check computers for obvious problems, fix the simple ones and
make recommendations to solve more
serious problems, such as the need for
new hardware, reinstallation of Windows
and major malware infections.

There will be a limited number of
spots available because the tuneups must
be completed during the meeting.
Those who sign up for a tuneup will
need to take the computer and the power
assembly for laptops. Also, if you have a
touch monitor or other non-standard
hardware, bring it also.

video, office, security and utilities.
The beauty of PortableApps is that
they all run from a flash drive and don’t
need to be loaded onto a computer
(although desktop/laptop versions are
available for many of the programs). To
use them, you plug the flash drive into
any computer that will accept one, do
your work, and store any documents or
other information you gather on the flash
drive. When you remove the flash drive,
no evidence of your presence is left on
the computer.
Most of the PortableApps are freeware. Microsoft has not released PortableApps versions of any of its programs,
but both OpenOffice and LibreOffice let
users open, edit and save Microsoft Office files.
PortableApps is “really great for those
of us doing support,” said Scott, who
prepared a PortableApps flash drive filled
with technical tools so he always has
them available when visiting customers.
(Continued on page 9)
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He can also store logins for support sites
that he uses often in PortableApps.
All of the programs demonstrated as
PortableApps have a standard Windows
install on the Freeware disk as well.
SIW (System Information for Windows)
One such computer tool is SIW
(System Information for Windows),
which tells you everything you have on
your computer. It’s “a tremendously powerful program in finding out what do I
have on my computer,” he said.
It reports information on a computer’s
hardware, driver versions and software
and gathers serial numbers, passwords
(which it reports the first several characters of) and other similar information.
Gramps
Gramps is a genealogy program that
reads, imports and exports standard GED
files, along with several other genealogy
program formats. Files can be saved in
several formats. Like many of the programs on the drive, Gramps comes in 32and 64-bit versions, so be sure to download the correct one (the PortableApps
version is 32-bit only). If you aren’t sure
if you have a 32- or 64-bit version of
Windows, go to Control Panel > System
to find out.
Gramps has all the usual genealogical
forms and ways to add information about
people, relationships, events, places and
sources. It creates many graphical reports,
including family trees, and “it will take
everything and export it as a Web page.”
“It’s a worldwide community that’s
working on this,” Scott said. “It’s gotten
more and more powerful over time.”
Gramps was originally developed for

Linux.
LibreOffice
LibreOffice was developed by many
of the people who helped develop
OpenOffice but who left when Oracle
bought Sun, which was supporting
OpenOffice.
Both programs can open Microsoft
Office files, let users edit them and then
save them in a Microsoft format or in
their own formats. Scott uses LibreOffice
rather than OpenOffice because he’s not
an Oracle fan either, he said.
LibreOffice and OpenOffice have
programs for word processing, spreadsheets, databases, drawings, math, and
presentations (similar to PowerPoint).
Shalkey noted that LibreOffice can
save files as PDFs.
Stellarium
Stellarium is a planetarium program
that lets users see the night sky from anywhere in the world at any date and time.
If you want more information about a sky
object, right clicking on it brings up an
information box. Stellarium will outline
constellations and show the constellation
names used by many cultures.
Users can add a horizon so they can
see what is visible from the ground. The
sky can be rotated 360 degrees, showing
users what they would see as they turned
in a circle.
IrfanView
Shalkey demonstrated IrfanView,
which is “so powerful that I prefer it over
PhotoShop,” he said.
Working with pictures he had taken
Saturday morning on his way to the CIPCUG meeting, he used batch conversion
to rename all the photos to something
more meaningful than the numerical

names given by the camera. He used the
name “Trip to CIPCUG” and added two
pound signs (##) so the program would
add numbers to the name. The number of
pound signs to use is determined by the
number of photos.
Shalkey then used batch converter to
make the pictures smaller so he could
send them by email. He created a new
folder so the original pictures would not
be overwritten, set the specifications for
the edited pictures and ran the program,
after telling it where to put the new, small
pictures.
IrfanView can create an email and
attach the photos to it so they can be sent
to others. It can also create a Web page
with both thumbnails and the larger photos.
IrfanView lets users erase portions of
a picture (phone lines in the picture
Shalkey was using), create text boxes in
the photo, and adjust colors and other
details. With GPhotoshow, it can create a
slide show that can be used as a screen
saver for Windows XP, Vista, 7 and 8.
The screen saver function puts different
pictures on multiple monitors. Slide
shows can be shown on televisions with
HDMI connections.
IrfanView was developed so it would
fit on a floppy, Shalkey said, and it remains a small program.
It can also play a variety of music and
video files, Shalkey said.
VLC Media Player
Scott mentioned that he prefers VLC
over Windows Media Center because it
plays anything he’s ever seen. Microsoft
was held up by some codec writers, who
wanted a fortune for Microsoft to license
their codecs. VLC doesn’t have the problem. It will play virtually anything.

MailWasher is helpful adjunct to email programs
By Tony Pizza
uring the Internet session at
the January meeting, there
were discussions about using
email. My comment was a
recommendation to consider MailWasher
as an email screening program for unwanted messages and spam. I heard about

D

it at a CIPCUG meeting years ago, back
in the dialup era, where it saved me much
time and annoyance from downloading
large and useless “funny” videos. I also
used it to delete problem emails at the
mail server that got stuck.
MailWasher comes as a free version
for one email address and a paid version

for multiple ones. I have a paid version on
my desktop, but don’t use all the capability. On my laptop and netbook, I find the
free version adequate.
MailWasher is free to use, won’t ever
expire, and works with Outlook, Outlook
Express, Incredimail, Thunderbird, Win(Continued on page 10)
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Minutes of the January
Treasurer’s report
board of directors meeting for December 2012
By Diane Mortensen-Henderson
IPCUG Board of Directors held its monthly meeting
on Jan. 26, 2013. Members in attendance were Jim
Brown, John Weigle, Andy Toth, Craig Ladd, Art
Lewis, Helen Long, Toby Scott, and Diane Mortensen-Henderson.
The meeting was called to order by President Jim Brown.
December board minutes: One correction to the December
board minutes was noted by Art; CIPCUG’s
insurance will be paid in February 2013, not has
been paid. With said correction, the Board of
Directors’ Minutes for Dec. 15, 2012, were approved.
Treasurer’s report: Art passed out copies of
the December 2012 treasurer’s report, which is
published elsewhere in TOE. Art explained that
Mortensen- the -$100 under Outflows, Corp. Exp., represents
Henderson
a refund from Parks & Recreation. The refund of
$100 was the security deposit CIPCUG’ paid for
the use of the park’s facilities for the 25th anniversary celebration.
Future programs: Craig announced that there was nothing
definite planned for CIPCUG’s February meeting. He thanked
Toby and Michael for their presentation on some of the freeware programs on the new CIPCUG flash drive. The consensus
was, when convenient, to have Toby and Michael do another
freeware presentation or perhaps two. Craig suggested that he
might be able to have Staples techs put on another presentation
on tablets.
CIPCUG members and others have mentioned an interest in
having program meetings and/or a SIG on digital cameras. Diane mentioned that she had attended a digital camera workshop
offered at the Camarillo Library. The first meeting had over 110

C

(Continued on page 12)

By Art Lewis
treasurer@cipcug.org
12-1-12 through
12-31-12

Lewis

Category Description
INFLOWS
Coffee Income
Membership Income
New Members
40.00
Renewals
230.00
TOTAL Membership Income
Raffle
Software Sales

270.00
124.00
760.00

TOTAL INFLOWS

1,151.10

-2.90

OUTFLOWS
Corporate Expenses
Raffle Prizes
Rent Paid
TOE

-100.00
70.23
150.00
258.12

TOTAL OUTFLOWS

378.35

OVERALL TOTAL

722.75

Unrestricted Funds
Restricted Funds
Bank Balance 12-31-12
Year to Date Income
Year to Date Expense
Net Year to Date

4,091.76
0.00
4,091.76
4,005.10
4,717.30
-712.20

More on MailWasher …
(Continued from page 9)

dows Mail, GMail, Hotmail and every other email program. You
set up MailWasher with the same information as your email account: incoming and outgoing mail servers and email password.
Basically, you can use it to delete unwanted e-mails before
you download to your computer, a great way to stop viruses,
large attachments or to just delete unnecessary emails from getting to your computer. Easily preview the message in your email
to see what the sender has to say before downloading it to your
computer. It has easy-to-use anti-spam tools and filters. I could
tell you more, but you can go to http://www.mailwasher.net for
more information and to download it.

2013 contributors to The Outer Edge
Your name can appear here,
too. Share your knowledge with
other members by sending an article,
letters or computer tips to
editor@cipcug.org.
CIPCUG MEMBERS
Ken Church
Art Lewis
Helen Long

Diane Mortensen-Henderson
Dick Maybach
Tony Pizza
Toby Scott
Michael Shalkey
Rick Smith
Jim Thornton
Bill Wayson
John Weigle
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December 2012 renewals payment due:

Membership report:

Is it time to renew?

Mbr# Last Name

By Ken Church
email address: membership@cipcug.org

Welcome –
New members: much appreciated

CHURCH

Attendance at the January 2013 general meeting:
63 members and guests (who signed in)
Total membership: 178

MEMBER RENEWAL INFORMATION
$30 for single membership,
$35 for two or more family membership.
NEW MEMBER INFORMATION
$40 first year for single membership,
$55 first year for two or more family membership in same household.
Please send your payment to:
CIPCUG MEMBERSHIP
P.O. BOX 51354
OXNARD, CA 93031-1354
Or bring your payment to the sign-in table for
the Feb. 16, 2013, meeting.

0037T Hosford
0993 Ladd
1001 Toth

First
Name
Victor
Craig
Andy

Pd to Dt
201212
201212
201212

January 2013 renewals payment due:
First
Mbr# Last Name
Pd to Dt
Name
0926 Curry
Rick
201301
1217 Donohue
Joseph
201301
0947 Ellis
Dick
201301
0554 Muskat
Vel
201301
0950 Skultety
Tony
201301
0836 Willett
Dr. Nancy 201301
February 2013 renewals payment due:
First
Mbr# Last Name
Pd to Dt
Name
1168 Brown
James
201302
1129 Escobedo
Ray
201302
1063 Field
Dwayne
201302
1063A Field
Sharon
201302
0412 Guess
John
201302
1219 Hernandez
Rafael
201302
0843 Isaman
Harry
201302
0566 Meeker
Kirsten
201302
0565 Meeker
Mary
201302
0656T Mori
Ken
201302
1184 Murray
Tom
201302
1183 Norbutas
John
201302
1218 Panczel
Marika
201302
1082 Perry
Jim
201302
1232 Riggan
Lee
201302
1135 Sherbrooke Rosalie
201302
1169 Smith
Donald
201302
1083 Stoutz
Hank
201302
1140 Wayson
Bill
201302
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Raspberry Pi: Some assembly required
By Bill Wayson
bwayson@gmail.com
hen I was young, I liked
the electronics kits you
could buy at most electronic stores. For not a lot
of money, you’d get a plastic box with
breadboard on the top, a bunch of parts,
and instructions on how
Penguin’s
to make whatever it was
Lair
that you got. The end
product could always be
bought ready made, but
the fascination of the kit
was that you learned to
build it yourself. I especially remember the
germanium crystal radio
and listening to broadcasts without any source
Wayson
of electricity other than
the radio signal itself. Today, there are a
variety of active do-it-yourself (DIY)
communities that can help you build lots
of different things yourself. Just search
DIY in your browser and see all the resources that are available for such a large
variety of projects. One relatively recent
newcomer to the DIY world is the Raspberry Pi, a mostly complete PC for $35 (a
$25 version is available and sold mostly
to educational institutions). Just download an operating system from the Raspberry Pi website, copy it to an SD card,
insert the card into the Raspberry Pi, connect an HDMI- or RCA video-capable

W

monitor or TV, insert a USB keyboard
and USB mouse, optionally connect a
standard network cable, and then a micro
USB power supply (which are often used
as smart phone chargers), and you are up
and running. For most, though, this is just
a start. The Raspberry Pi begs to be experimented with.
As well it should. The Raspberry Pi
was conceived by Eben Upton and his
colleagues at the University of Cambridge in Great Britain to address a problem they were experiencing in the early
2000s. The top-level applicants for their
Computer Science program had declined
both in numbers and skill level. Whereas
earlier top-notch applicants were experienced programmers, by then the best applicants knew little more than how to use
a computer and, maybe, a little Web design. One concern the Cambridge group
had was that personal computers had become so expensive and difficult to program that kids were not allowed by their
parents and schools to really explore
them, open them up, and tinker with them
(and maybe kill them). So they started
working on a small PC, cheap enough
both for a kid to buy and to not be too
concerned with destroying. They wanted
it to boot up into an environment conducive to learning programming skills.
Their original goal for the Pi was to create an inexpensive platform for learning
computer programming.
Sales of the Raspberry Pi began in

early 2012 with the thought that maybe a
few thousand would be sold. But, since
then, a million or so units have been purchased. They continue to sell as fast as
they can be made, and a solid community
of young and adult users of the Pi has
created projects that use and enhance it
far beyond its learning programming
goal. From the Raspberry Pi About Us
Web page, “[d]eveloping countries are
interested in the Raspberry Pi as productivity devices in areas that simply can’t
afford the power and hardware needed to
run a traditional desktop PC; hospitals
and museums have contacted us to find
out about using the Raspberry Pi to drive
display devices. Parents of severely disabled kids have talked to us about monitoring and accessibility applications; and
there seem to be a million and one people
out there with hot soldering irons who
want to make a robot.” Raspberry Pi-es
have been used to remotely feed cats using a smartphone all the way to streaming
live video, and taking photos and environmental measurements at nearly 25
miles up hung from a weather balloon.
What’s more is that there are posted on
the Web instructions on how these things
were done, which can be read by anyone,
enabling them to do the same thing. One
Raspberry Pi distributor uses Pi-es and
custom software to streamline its receiving and shipping system. An online magazine, The MagPi, is devoted to the Rasp(Continued on page 13)

More on board minutes ...
(Continued from page 10)

people in attendance and second session
over 80. CIPCUG could put on a workshop on digital camera software dividing
it up into two or three sessions. Board
members agreed it would be an excellent
marketing opportunity for the club.
TOE survey: John has completed
CIPCUG’s survey and as of this date received three surveys off of CIPCUG’s
website and six handed in at today’s
meeting. By the end of February, John

will tally and present the results.
Attendance: Ken reported that there
were 65 attending today’s meeting. A
member of the board remarked that the
larger-than-normal attendance could have
been because of Toby and Michael’s
presentation on freeware programs. Another remark was made that after the
presentation, many people left, which
indicated to him that not many raffle tickets were sold even though the prizes were
some of the best.

Computer tuneup: Discussion was
had on having another computer tuneup
session in April. It was suggested that as
an incentive to join CIPCUG anyone who
joins from January to the day of the April
meeting can have a free tuneup. A flier
could be made up publicizing the membership/tuneup special and distributed
locally.
There being no further business to
discuss, the meeting was adjourned at 1
p.m.
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Microsoft Windows shortcut keys
By Jim Thornton
jasthorn@gmail.com
ll of the Microsoft Windows
computer programs include
many keyboard shortcuts. In
addition, if you have a Microsoft keyboard, the more common
shortcuts are printed on the individual
keyboard keys. One of the more common
shortcuts uses your control (CTRL) key
and another key. Here are the more common ones.
CTRL+ letter combinations
CTRL+A = All. Select all items in the
current window.
CTRL+B = Bold.
CTRL+D = Desktop.
CTRL+F = Find.
CTRL+C = Copy.
CTRL+E = My PC.
CTRL+G = Go. Opens the Go To
Folder tool (in Windows 95 Windows
Explorer only).
CTRL+I = Italic.
CTRL+N = New.
CTRL+P = Print.
CRTL+U = Underline.
CTRL+X = Cut.
CTRL+L = Lock.
CTRL+O = Open.
CTRL+S = Save.
CTRL+V = Paste.
CTRL+Y = Redo.
CTRL+Z = Undo. Undo the last com-

A

mand.
There are eight keys without the
shortcut features. These keys are H, J, K,
M, Q, R, T, and W. I find it very easy to
use the Copy, Cut, and Paste shortcut
keys when using my Microsoft Word
program and the program is identifying a
word that I want to move as a misspelled
word and doesn’t let me use the regular
Copy, Cut, and Paste functions of Word.
And don’t be concerned that not all of
these shortcut keys are working on your
computer. I have less than half of these
shortcuts working on my Windows 7
computer.
CTRL+ nonletter key combinations
And here are more keyboard shortcuts
using your CRTL key with other nonletter keys on your keyboard:
CTRL+ALT+DEL = Open the Windows option screen for locking computer
or switching users, or displaying Task
Manager, etc., in later versions of Windows. Pressing the CTRL+ALT+DEL
multiple times will reboot your computer.
CTRL+ESC = Opens your Start menu
in most versions of Windows. In Windows 8, this will open the Start screen
and in Windows 3 this will display your
Task Manager. Press Tab to select the
taskbar or press SHIFT+ESC to display a
context menu.
CTRL+SHIFT+ESC = opens your
Windows Task Manager.

CTRL+SHIFT+TAB = Reverses the
direction of the CTRL+TAB shortcut
keys.
CTRL+TAB = Switches between program groups, tabs, or document windows
in application that support this feature.
Reverse the direction by pressing CTRL+
SHIFT+TAB at the same time. Switches
between program groups, tabs, or document windows in applications that support this feature.
CTRL+F4 = Closes your current multiple document interface (MDI) window.
CTRL+WINKEY+F = Find computer.
CTRL+WINKEY+TAB = Moves
focus from Start to Quick Launch toolbar.
Windows key combinations
Here is a second group of more popular keyboard shortcut using the Windows
button (WINKEY) with another keyboard
key.
WINKEY = Start menu.
WINKEY+A = Starts accessibility
Options (if installed).
WINKEY+C = Opens Control Panel
or opens the Charms.
WINKEY+D = Minimizes all open
windows and displays desktop.
WINKEY+E = Windows Explorer.
WINKEY+F = Find or search for files
or folders.
WINKEY+F+CTRL = Find comput(Continued on page 14)

More on Penguin’s Lair ...
(Continued from page 12)

berry Pi and what can be done to it. A
Web search for Raspberry Pi will show
you that there is tremendous interest in
this product.
The Raspberry Pi is truly a cool product and idea. It also serves as the latest
reminder that the desire to learn is still
strong, and that no matter how clever and
inventive you think you are, there is always someone who can take your idea
and show you something even more clever and inventive that you had never even
thought of.

If you are, or know of, an educator
who is interested in this, I recommend
that you contact the Raspberry Pi Foundation to see how the Pi can be used in
school and class.
If you have any personal interest in
the Raspberry Pi, just search the Web
using Raspberry Pi Projects and see what
you can do with it. I’d bet that after doing
so, you’d be hard pressed to not lay down
your money and order one online. And, it
may very well not be the last one you
order.
If you have questions or would like to

learn more about Linux and FOSS, come
to the February CIPCUG Linux SIG
meeting at 6:30 p.m. Wednesday the 27th
at Ventura County Computers in Ventura.
Note that the meeting date is not the
normal fourth Tuesday of the month.
With luck, we will finally get Ubuntu
installed on our refreshed CIPCUG PC.
Of course, we can talk about the Raspberry Pi or anything else that interests you.
If there is something you would like
the Lair or Linux SIG to cover, drop me a
line at bwayson@gmail.com. Until next
month, happy computing.
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er.
WINKEY+G = Cycle through Desktop gadgets.
WINKEY+H = Opens Share in
Charms.
WINKEY+I = Opens mouse properties dialog box or open the settings in
Charms.
WINKEY+J = Switch between
snapped apps.
WINKEY+K = Opens keyboard properties dialog box or open Devices in
Charms.
WINKEY+L = Locks your computer
without using CTRL+ALT+DELETE or
logs off windows.
WINKEY+M = Minimize all windows.
WINKEY+M+SHIFT = Undo minimize all windows.
WINKEY+O = Lock the screen orientation.
WINKEY+P = Start Print Manager.
WINKEY+R = Run dialog box.
WINKEY+S = Toggles Caps Lock on

and off.
WINKEY+T = Set the fours on the
Taskbar icons.
WINKEY+U = Opens Utility Manage
to the Ease of Access Center.
WINKEY+V = Starts clipboard.
WINKEY+X = Opens the power user
menu.
WINKEY+F1 = Help.
WINKEY+BREAK
or
WINKEY+PAUSE = System properties
dialog box.
WINKEY+CTRL+F = Displays the
search for computer windows.
WINKEY+DOWN ARROW = Minimizes the screen.
WINKEY+ENTER = Opens other
non-open windows.
WINKEY+HOME = Minimizes all
windows except for the active windows.
WINKEY+LEFT ARROW = Reduces the screen size to half screen on the
left side for side-by-side viewing.
WINKEY+PLUS = Opens the Windows Magnifier and will zoom in if you
used the plus symbol or will zoom out if

you used a minus symbol.
WINKEY+RIGHT ARROW = Reduces the screen size to half screen on the
right side for side-by-side viewing.
WINKEY+SHIFT+M = Reverse what
was
done
by
WINKEY+D
or
WINKEY+M.
WINKEY+SPACEBAR = Displays a
list of the Microsoft Intel Type shortcut
keys.
WINKEY+TAB = Cycle through
taskbar buttons.
WINKEY+TAB+CTRL+TAB
=
moves focus from Start to Quick Launch
toolbar.
WINKEY+UP ARROW = When
viewing the side-by-side screen, this reduces the screen back to a full screen.
WINKEY+1 = Opens the first program on your Taskbar. Plus any other
number besides one will open the program on your Taskbar based on its position.
On the Microsoft Web page http://
support.microsoft.com/kb/126449
pro(Continued on page 15)

(805) 289-3960
2175 Goodyear Ave. #117 Ventura 93003

Would someone please explain
to me why anyone in their right
mind would choose Windows
windows 88
when you have Windows
windows 7.
7.It’s
It’s
like jumping out of a perfectly
good airplane.

Rick, I gave you Microsoft’s talking
. points.
All you have to do is
it tow
toe the
the
company line to start selling new PCs
PC’s
with the world’s most advanced OS.
Get with the program!

As everybody knows I’m always right about everything and
there’s nothing I’m not knowledgeable about. And I know
this,Rick,
Rickyou’re
your wrong
this,
wrongabout
about
windows 88 and
Windows
and if
if you
you have
have 22
hours I’ll tell you why.
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At least one option
not recommended to
gain hard drive space
By Dick Maybach
March 2012 issue, BUG Bytes, Brookdale Computer Users’
Group, NJ
www.bcug.com
n2nd (at) charter.net
hen buying a new PC, it’s usually wise to equip it
with the largest possible hard disk.
Despite this, it's not uncommon to find that
eventually it becomes uncomfortably full, leaving you with four options:
1. Save all your user data on an external disk, replace the
system disk with a larger one, install Windows and all your applications from scratch, and restore your user data from the external disk,
2. Make an image of the current disk on an external drive,
replace the current hard disk, and restore the image to it,
3. Add a hard disk and move some data folders to it, or
4. Enable dynamic disk management, which makes multiple
disks appear as one, thus increasing the available space.
If your Windows 7 installation is corrupted by file system
errors or malware, you must use option 1. If your system is
working well, use option 2 (using the Windows 7 Backup and
Restore tool), which is substantially easier and faster than 1. If
your current system is working well, option 3 looks attractive,
but there are significant issues, which I discuss below. I don't
have the resources to test option 4, and I’ve learned from sad
experience not to write about things I haven’t done. If you are
interested in dynamic disk management, see a good book, such
as “Window 7 In Depth” by Cowart and Knittel. However, this
approach appears to be complex enough to make it useful only in
a professionally staffed computer center. I don’t recommend it
for home users.
Option 3, add a second hard disk and move some of the data
folders from our home folder to it, looks attractive. Here, some
data will reside on a different drive, call it D:, and unfortunately,
some programs, for example iTunes, cannot access data on it.

W

(Continued on page 16)

More on shortcuts ...
(Continued from page 14)

vides a listing of numerous Windows key combinations. On this
website, you will see several other keyboard shortcuts starting
with the keyboard keys: ALT, LOGO, F, and SHIFT. I will provide the more of these other shortcut keys in a future article.

Members’
classified ads
Classified ads are free to
members. Each ad is limited
to 105 characters, including
spaces and to one ad per
member per month. Copy has
to be to John Weigle, editor of
TOE
(editor@cipcug.org),
within the week after the
regular meeting. Otherwise,
the ad is held to the following
month.

Free

Manual
(.pdf)
http://
pdf.textfiles.com/manuals/
FAXMACHINES/Sharp%
20UX300%20Plain%
20Paper%20Fax%
20Machine.pdf — David Minkin
I have the following For Sale
(contribution to CIPCUG):
2 each Microsoft Mouse, $2
each
Internet
Scrolling
Mouse
(COMP USA), $2
Video Selector Switch (5 inputs/2 outputs), $5 — David
Minkin

For sale

I have the following Free/For Wanted
Sale (contribution to CIPOther categories
CUG):
One SHARP UX-300 FAX as needed
machine with Handset
The Outer Edge is printed and prepared for mailing by:

Page 16

The Outer Edge

February 2013

General news and commentary

xxx

Figure 1: This is the Create and format hard disk partitions window of the Windows Disk Management tool.
(Continued from page 15)

You can edit iTunes’ preferences to declare that, iTunes Media, the folder that
holds its music, resides on D:, but iTunes
apparently doesn’t look outside your
home folder. There are probably other
applications with similar flaws.
A procedure called grafting appears to
offer a solution. It maps all the files on an
auxiliary disk into a folder in your home
folder, and any files you later add to that
folder are stored on the grafted disk. The
basic procedure is as follows:
● Copy all the files in the selected
folder to the auxiliary disk;
● Delete the selected folder on the
main disk; and
● Graft the auxiliary disk to a folder
on main disk.
This indeed works on Windows 7, and
after I did it, iTunes was able to find its

files on the auxiliary disk,
but operations were so flaky
(see below) that I wouldn’t
do this on a PC that I actually used.
If you would like to
experiment (not on the PC
you use for TurboTax,
please), here is the procedure. Log in to an account
with administrator privileges, and open the Disk Management tool. (The easiest
way is to tap the Windows
key or click on Start, type
“disk manage” and select Figure 2:This is the Browse for Drive Path window.
Create and format hard
disk partitions.) The screenshot in Figure click on NTFS-2 (F:) and select Change
1 shows the result.
Drive Letter and Paths … . Click the Add
In this example, I graft NTFS-2 (F:) … button, select Browse … , navigate to
onto a folder in my home folder. Right(Continued on page 17)
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Book review

Need answers? Here’s how to find them
By John Weigle
jweigle@vcnet.com
Google is the researcher’s friend —
but it should never be the last resort.
That’s the cogent advice of Don MacLeod, a law librarian for more than 25
years at four large New York City lawfirms and, since 1995, the editor of the
“Internet Law Researcher” newsletter.
Although the second and third chapters of his book are devoted to Google,
the fourth chapter is “Why you still need
a library card.”
MacLeod offers many key points for
those conducting research of any kind:
Ask the right question (“Is xxx a good
idea” can’t be answered by research because it’s an opinion; “what effects might
result from xxx?” can at least come up
with good and bad points of whatever is
being proposed, he says.
Other ideas: Learn to evaluate the
information you find (for instance, where
does it come from?, how current is it?);
don’t do a lot of legwork that someone
else has already done (instead, find out
what individuals and groups have already
gathered it and ask them for it); learn

“How to Find Out Anything —
From Extreme Google Searches to
Scouring Government Documents,
a Guide to Uncovering Anything
about Everyone and Everything,”
by Don MacLeod, August 2012,
Prentice Hall Press
where and how to find public records,
which contain reams of information about
individuals, organizations and businesses.
He also points out that research builds
on itself because one piece of information
often leads to another, which leads to
another and so on.
MacLeod recommends that anyone
involved in research have immediate access to some basic reference works: an
almanac; dictionary; thesaurus; atlas;
directory of products and manufacturers;
tables for equations, mathematics and
conversions; a collection of quotations; a
basic history of the U.S. and world; a
library catalog; and a searchable collection of classic literature. Much, if not all,
of this information is available on the
Internet, and the book includes many
lists of recommended Web sites and

printed material.
MacLeod recommends a couple of
major Web sites that every researcher
should bookmark:
● The federal government’s portal:
www.usa.gov. It includes links to states’
websites.
● The Securities and Exchange Commission’s EDGAR: www.sec.gov/edgar/
searchedgar/webusers.htm and a related
site that describes what information can
be found in SEC filings at www.sec.gov/
info/edgar/forms/edgform.pdf. He says,
however, that those requiring detailed, indepth reports based on SEC filings might
be better off to hire one of the professional firms that specialize in such research.
And at the local level, he notes something that most reporters learn early on:
“County clerks’ offices are rich hunting
grounds for factual information, particularly liens and real estate records.”
The book is an excellent value for
anyone who ever has to seek out information beyond what’s in Wikipedia — a
source that does not impress MacLeod
unless your research involves popular
culture.

More on gaining hard drive space ...
(Continued from page 16)

the folder where the original folder appeared (in my case C:\users\n2nd), click
the New Folder button. The result is
shown below.
Click the OK button, and the Browse
for Drive Paths window will close, then
click OK in the Add Drive Letter or Path
window, and close the Disk Management
window. The disk NTFS-2 (F:) is now
grafted
on
the
folder
C:\Users\n2nd\New Folder. If you had to
log in as a different user to obtain administrator privileges, log out and then log
back in to your home account, in my case
n2nd.
This seems straightforward, but there
are several traps. The Disk Manager is
quirky and not well documented. I needed

several attempts to make the above procedure work, which isn’t good for a tool
that modifies your folder structure. Since
you can graft an entire disk only to a single folder, if there are several large folders, you must partition the auxiliary disk
and graft a separate partition to each folder. This is unfortunate, because you can’t
graft your entire home directory, as it
contains system files that are always in
use. Most disturbing is that when I finished and tried to make a full backup,
including a system image, the procedure
failed. Even if it had succeeded, I’m not
sure I could have restored my system.
Would the software try to put everything
on the original (now too small) C: disk, or
would it be smart enough to restore to
both C: and F: and graft F: to a folder?

This isn’t something about which you
want to be surprised when you have to
restore your files.
My conclusion after all this is that
Windows 7 is designed to operate from a
single disk, as are some of its applications. In this respect, it’s made a step
backward from XP, where you could locate your My Documents folder on any
disk, and even iTunes could find its files
there.
You can add additional disks to a
Windows 7 system, but accessing files on
them will be somewhat less convenient
than if everything resided in your home
folder. As a result, if you run out of disk
space on a Windows 7 PC, the best
course is to replace the disk with a larger
one and port your system to it.
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Initials
BDV

Name
Bob de Violini

(805)
rjddev@gmail.com

BR

Bill Robinson

389-2997 (b)
bill@bzus.com

DM

David Minkin

469-6970 (cell);
484-2974 (home);
dddave@cipcug.org

MS

Michael Shalkey mshalkey@cipcug.org

RP

Robert Provart

498-8477 (b)

Phone: (d) = days; (e) = evenings; (b) = both

F1—Your Help Key
(Revised Sept. 7, 2008)
COMMUNICATIONS/INTERNET (GENERAL)
World Wide Web
DM
DATABASES
Access

BR

DOS

RP

E-MAIL
Outlook
Outlook Express
Thunderbird

MS
BR, DM
MS

GRAPHICS PROGRAMS
IrfanView
Paint Shop Pro
Photo Shop Elements
Print Shop

MS
DM
BR
BR

SPREADSHEETS
Microsoft Excel

DM

WORD PROCESSING
Microsoft Word
WordPerfect

DM
DM

WINDOWS
Windows 98, 95
Windows 2000
Windows XP

DM, MS (98)
BDV
DM

If you would like to volunteer to help others, please send
your contact information and programs you’re willing to
help on to editor@cipcug.org.
........................
WEB HELP SITES (Updated 10-02-12)
Steve Bass TechBite Newsletter registration page:
www.techbite.com
DSL reports: www.dslreports.com
Steve Gibson: www.grc.com
Kim Komando: www.komando.com
Leo Laporte: www.leoville.com
Jeff Levy: www.jefflevy.com
Linux distributions: www.DistroWatch.com
Microsoft: www.microsoft.com
OnGuard Online: http://www.onguardonline.gov
PCMag: www.pcmag.com
PC Pitstop: www.pcpitstop.com
PC World: www.pcworld.com
Recalled products: www.recalls.gov
SANS Institute — Computer Security Education and
Information Security Training: www.sans.org
Smart Computing: www.smartcomputing.com
Spyware Warrior: www.spywarewarrior.com
User Group Relations (Gene Barlow): www.ugr.com
Ventura County Computers (Rick and Toby’s shop):
www.vccomputers.com
Virus Bulletin: www.virusbtn.com/index
Windows Secrets: www.windowssecrets.com
Windows
The
Official
Magazine
(UK):
www.officialwindowsmagazine.com/

If you have a favorite help site on the Web, please forward
it, so we can expand the section. If you find a link that
doesn’t work, please tell us that, too.
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Why join Channel Islands PC Users
Group (CIPCUG)?
Every month, members of the Channel
Islands PC Users Group have access to:
♦ The Outer Edge newsletter, which
includes a list of members willing to help
other members.
♦ The general meeting, featuring a
question-and-answer session and program
on new software or hardware.
♦ Special Interest Groups — special
meetings held monthly.
♦ Door prizes and raffle at the
regular meeting.
Other benefits include:
♦ Special user group discounts on

books and software.
♦ A flash drive containing many
useful freeware programs.
♦ A chance to make friends with
people who have similar interests.
♦ The ability to put your knowledge
to good use by helping other members.
The whole concept of user groups is
members helping members.

CIPCUG.
Dues for new members
Individual member, $40.
Family membership (same address),
$55.
Renewals are $30 and $35 per year
respectively.
TOE subscription only (in the U.S.),
$20.

CIPCUG E-MAIL ADDRESS
Please clip the coupon below and send
Members who would like to have an
with payment to CIPCUG-Membership,
email address through CIPCUG in the
P.O. Box 51354, Oxnard, CA 93031form of YourName@cipcug.org may ob1354.
tain one for $20 per year.
Please make checks payable to

CIPCUG MEMBERSHIP
APPLICATION

Can you help the club as a volunteer? If so, what would you
be interested in working on? Please list on separate sheet. If
necessary.

Amount enclosed: ____________________________
Please Print the following information:

For CIPCUG use:
Date __________________

Name: _______________________________________
Member # ____________
Address: ______________________________________

City: ___________________________,

State:________ ZIP Code: ________________

Phone (Home): ______________(Work): ______________

E-mail address: ________________________________

User level: Novice ____; Intermediate _____;
Advanced _____

The Outer Edge
Channel Islands PC Users
Group Inc.
Page 20

P.O.Box 51354
Oxnard, CA: 93031

NON-PROFIT
February 2013
U.S. POSTAGE
PAID
OXNARD. CA
PERMIT NO. 1785

DATED MATERIAL
Please Do Not Delay

Update wording
DUES REMINDER
If the code above your
name is 2013 FEBRUARY, your membership
dues are payable in FEB-

February 2013 meeting
of the Channel Islands PC Users Group
The map shows
the easiest route
to the Boys &
Girls Club, but if
you prefer, you
can take the
Carmen Drive
offramp to
Ponderosa Drive,
which leads to
Temple Avenue.

Saturday morning, Feb. 23, at the Boys &
Girls Club, 1500 Temple Ave. (Ponderosa
Drive and Temple Avenue), Camarillo.
Meeting schedule:
8:00 a.m.
Doors open
8:30
SIGs (Depending on available space
we will have a connectivity and email
SIG and a social media/tablet/
smartphone SIG
9:30
Business meeting
10:00
Q&A
10:30
Break
Program (TBA)
Drawing

